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Read Me First 
Welcome to Take Control of iTunes 12: The FAQ, Second Edition, 
version 2.0, published in February 2017 by TidBITS Publishing Inc. 
This ebook was written by Kirk McElhearn and edited by Tonya Engst. 

This ebook shows you how to manage your audio and video libraries 
in iTunes and in Apple’s cloud, stream tunes from Apple Music, and 
sync content to your iOS devices. If you want to become an iTunes 
power user, this ebook is for you. 

If you want to share this ebook with a friend, please do so as you would 
with a physical book: “lend” it for a quick look, but ask your friend to 
buy a copy for careful reading or reference. Discounted classroom and 
Apple user group copies are available. 

Copyright © 2017, Eyes of the World Limited. All rights reserved. 

Updates and More
 

You can access extras related to this ebook on the Web (use the link in 
Ebook Extras, near the end; it’s available only to purchasers). On the 
ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or buy
any subsequent edition at a discount.

•	 Download various formats, including PDF, EPUB, and Mobipocket.
(Learn about reading on mobile devices on our Device Advice page.)

•	 Read the ebook’s blog. You may find new tips or information, as
well as a link to an author interview.

If you bought this ebook from the Take Control Web site, it has been 
added to your account, where you can download it in other formats 
and access any future updates. However, if you bought this ebook 
elsewhere, you can add it to your account manually; see Ebook Extras. 
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Basics
 

Here’s an overview of the iTunes interface (Figure 1) and the terms 
that I use. 

Figure 1: Learn about the iTunes interface by matching the numbers 
above with the descriptions below. 

Playback controls: Near the left of the toolbar, the playback con-
trols include the Play button, which becomes a Pause button 
when you play media, and the Previous  and Next buttons. 

Volume slider: Drag this slider to adjust iTunes’ volume. 

AirPlay button: Click this button to stream music (or video) to an 
AirPlay device (see How Do I Play Media over a Network?). 

iTunes LCD: Look here, in the center of the toolbar, for 
information about the media you play, as well as messages about the 
progress of CD rips or sync sessions with iOS devices. 

Up Next button: Click this to see the Up Next queue, lyrics, and 
your play history (see How Do I Use Up Next? and How Do I Sing 
Along with My Music?). 
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Search box: This box, at the right of the toolbar, is where you 
search for content in your iTunes library, Apple Music, or the iTunes 
Store. (See How Do I Search in My Library?.) 

Back and Forward buttons: These buttons, at the left of the 
navigation bar, let you go back and forward as you do in a Web brows-
er. No matter where you are in iTunes—in your library, in the iTunes 
Store, or in Apple Music—these buttons take you back to where you 
were before. 

Media Picker: This menu, near the left of the navigation bar, lets 
you choose a type of media to view (see How Do I Use the Sidebar?). 

Navigation bar buttons: The buttons at the center of the naviga-
tion bar control where you view a type of media. For example, if you 
choose Music from the Media Picker, you can click iTunes Store to go 
to the iTunes Store, or if you have an Apple Music subscription, click 
For You to see Apple Music’s recommendations. (See What Are Those 
Buttons in the Middle of the Navigation Bar?.) 

Sidebar: The sidebar displays the library that you’ve chosen in 
the Media Picker, so long as you’ve selected the Library button in the 
center of the navigation bar. From the sidebar, you can select different 
ways of viewing your media and view your playlists (see How Do I Use 
the Sidebar?). 

Status bar: Look here for information about the main section of 
the iTunes window: how many items are in the view (or selected in the 
view), the playing time of this content (or the selected content), and 
the size of this content (or the selected content). The Status bar is not 
visible by default; to display it, choose View > Show Status Bar. 

Note: To review additional background information that might help 
you understand this book better, such as finding System Preferences 
and working with files in the Finder, read Tonya Engst’s free ebook 
Read Me First: A Take Control Crash Course, available for free on the 
Web or as a standalone ebook. 
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Links
 

All blue text in this book is hot, meaning you can click (or tap) it, just 
like a link on the Web. Some links take you to a Web page. Others go to 
a different part of the book. If you click a link that takes you to a differ-
ent part of the book, you can return quickly to the previous spot if your 
ebook reader offers a “back” feature. For example, in iBooks, click the 
“Back to” link at the lower left. Or, in Preview on the Mac, choose Go > 
Back or press Command-[. 

What’s New in The Second Edition
 

This new edition has two major changes: 

•	 iTunes 12.5: The text is updated throughout to cover iTunes 12.5, 
a major release of iTunes that accompanied Apple’s rollout of 
macOS 10.12 Sierra. The book also includes many small changes 
that Apple has made in iTunes between 12.5 and 12.5.5: see What’s 
New in iTunes 12.5. 

•	 Improved organization: The information about cloud-based 
features has been reshaped to better reflect the way iTunes now 
works, and I’ve moved most of it to the front of the book. I’ve also 
grouped all the information about Podcasts into its own chapter. 

If certain sections are no longer where you remember, to find what 
you need, use the table of contents or iTunes Quick Start, or the 
search feature in your ebook reader. 

Note: iTunes 12.5 requires at least 10.9.5 Mavericks, so if you still
 
use 10.8 Mountain Lion, you need to stick with iTunes 12.4. If you
 

are using Mountain Lion and want to download the previous edition
 

of this title, which covers iTunes 12.4, go to Ebook Extras and look
 

in the book’s blog.
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Introduction 
When iTunes was introduced in 2001, it was a fairly simple app. Back 
then, it allowed users to organize, browse, and play their music collec-
tions. It could play CDs, burn CDs, and rip CDs in MP3 format only. 
It could play MP3 files and sync those music files to a handful of MP3 
players. 

A lot has changed since that first version. iTunes is now a media center 
that organizes, plays, and syncs not only music files (in several for-
mats), but also videos, audiobooks, podcasts, apps, and more. 

iTunes now streams music from Apple’s cloud servers: both music 
you own and music you rent through Apple Music. Launched in 2015, 
Apple Music hosts more than 40 million tracks from the iTunes Store, 
integrates tightly with your existing iTunes library, and works with 
Apple apps on both iOS and Android. In fact, Apple Music is already 
one of the biggest streaming music services in the world. 

The iTunes Store has become a vast digital bazaar, selling music, 
movies, and TV shows, as well as offering video rentals and podcast 
subscriptions, housing the hugely successful App Store, and selling 
ebooks. 

To accommodate all these features, the iTunes interface has become 
increasingly complicated. While some basic functions, such as ripping 
CDs and creating playlists, are simple, the finer points of these fea-
tures—such as which format and bit rate to use when ripping CDs, and 
how to create useful smart playlists—are arcane. iTunes has hundreds 
of discrete features, and understanding the subtleties can be difficult. 

I’ve long been a serious music fan, and I’ve amassed a music collection 
that contains more than 100,000 tracks, made up of thousands of CDs 
I’ve ripped and thousands of tracks I’ve purchased from the iTunes 
Store and other sources. I’m a big listener of classical music (more 
than half of my library), and one of my special loves is German art 
songs, or lieder. But I’m also a Deadhead (a fan of the Grateful Dead) 
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and have hundreds of recordings of their live concerts. I like jazz, pro-
gressive rock, ambient music, vintage punk rock, and much more. I 
also regularly listen to audiobooks and podcasts, and I enjoy listening 
to audio recordings of Shakespeare’s plays. I also have a substantial 
video library, containing movies, TV shows, and music videos. 

I currently own two Macs, an iPhone, two iPads, several iPods, an 
Apple Watch, and two Apple TVs. Over time, I have confronted the 
many hurdles that make using digital content on these devices a chal-
lenge. As a Senior Contributor to Macworld, I’ve written hundreds of 
articles about using iTunes and iOS devices, notably for Macworld’s 
“Ask the iTunes Guy” column. (I’ve included links to some of my 
articles to provide more information than will fit in this book.) 

In this book, I share much of what I’ve learned about iTunes. The wide 
range of music that I listen to, and the variety of content in my iTunes 
library, has led me to discover the most practical and efficient solu-
tions to the problems of ripping, tagging, organizing, managing, play-
ing, and syncing a large media library. 

There are several aspects of iTunes that I don’t deal with. I don’t cover 
buying, organizing, or syncing iOS apps. I mention only briefly apps 
used to play digital content on iOS devices, such as Apple’s Music app. 
I discuss syncing in order to show you how to put media—audio, video, 
and ebooks—on Apple’s iOS devices, but I don’t cover syncing other 
types of data, such as contacts, calendars, and photos. 

This book is a carefully organized compendium of the iTunes wisdom 
that I’ve accumulated over the years. Because each person’s path to 
iTunes happiness will be different, I’ve crafted each chapter with a 
question-and-answer format, making it easy for you to browse to the 
information you need. 

If you’ve ever been frustrated while trying to wrangle your music, 
videos, podcasts, or audiobooks in iTunes, or if you’ve wondered 
how to get the most out of the program’s features, read on. 
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Compatibility: This book focuses on using iTunes 12.5 with macOS 
10.12 Sierra. If your Mac is running 10.9 Mavericks (at least 10.9.5 
is required), 10.10 Yosemite, or 10.11 El Capitan, you’ll find that 
most of this book is in line with these older versions of OS X—though 
perhaps with minor modifications. 

Note for Windows Users 
The screenshots in this book show the Mac version of iTunes; howev-
er, the Windows version is almost exactly the same. With the excep-
tion of a handful of very small points and the “bonus” chapter at the 
end of the book, everything I discuss applies to both the Mac and 
Windows versions of iTunes. 

A notable difference is keyboard shortcuts. When I talk about press-
ing the Command key together with another key, to carry out an 
operation, Windows users should press the Control key. When I say 
to press the Option key, Windows users should use the Shift key. 
Check the iTunes help for a full list of shortcuts. 

Another important difference is opening the iTunes preferences. In 
Windows, you choose Edit > Preferences. 
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iTunes Quick Start 
This Quick Start describes what you can learn in each chapter. You 
can go to the beginning of any chapter to view a list of that chapter’s 
specific topics. Click (or tap!) any chapter title to jump to the content. 

Optional warm-up reading: 
• To review basic navigation in iTunes, flip back to Basics.

• To explore changes in iTunes 12.5, see What’s New in iTunes 12.5.

Play music, videos, audiobooks, and more: 
Beyond finding the answer to How Do I Start Playing Music?, read Play 
to discover Shuffle and Genius, features that help you enjoy music in 
different ways, and Up Next, which lets you queue music for a listening 
session. The chapter also helps you play videos and audiobooks and 
explains how to play media through other devices, and even control 
iTunes with Apple’s iTunes Remote iOS app. 

Stream music: 
Explore the features in Apple Music, Apple’s streaming music service, 
including on-demand streaming, music discovery, curated playlists, 
and recommendations, plus a live radio station. Read Stream. 

Use iTunes in the Cloud and iCloud Music Library: 
Find the answer to What Cloud Services Does iTunes Use?, learn how 
to access the iTunes Store to re-download purchases, and get your 
head around how iCloud Music Library works with either Apple Music 
or iTunes Match. Read Cloud. 

Share your iTunes library on a home network: 
To make iTunes part of a media network in a home or office, set up 
either Media Sharing or Home Sharing. Read Share. 

Buy music, audiobooks, movies, and TV shows: 
It’s easy to buy music online from a variety of vendors, but since the 
iTunes Store is an integral part of iTunes, I look at using the iTunes 
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Store to add music, videos, and more to your iTunes library. I also 
explain how to move digital content into iTunes. Read Buy. 

Listen to podcasts: 
Podcasts can provide a nearly endless source of free information, 
entertainment, and companionship. Read Podcasts to find, organize, 
manage, and enjoy podcasts. 

Tag media so you can organize and find it later: 
Tagging media files is the most important thing you can do to take 
control of your iTunes library. You could just add all your media to 
your iTunes library and play it at random, but without correct tags, 
you’d never find what you want and you wouldn’t be able to make 
unique smart playlists. I’ll show you which tags you can change, how 
to change them for single and multiple items, and more. Read Tag. 

View your media library in iTunes: 
You’ve ripped and bought music and videos, and you’ve tagged your 
files. You’ve also subscribed to Apple Music, and you’ve amassed a 
growing collection of podcasts. Now you need to choose the right way 
to view your expanding media library so you can find what you want 
easily. Read View. 

Get organized with playlists and advanced file management: 
Playlists let you organize your music so you can do more than play 
songs by album, or at random. You can even set up listening sessions 
with smart playlists, which use tags to find what you want to hear auto-
matically. Read Organize for help with playlists as well as for informa-
tion about how iTunes stores your files so you can find them on your 
computer if you ever need to. 

Find content in your iTunes library: 
The larger your library, the harder it is to find what you’re looking for, 
and sometimes you want to find a specific song, album, or movie 
quickly. I’ll also explain how to tidy your library by finding duplicates. 
Read Search. 
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Sync media to an iPhone, iPad, or iPod: 
I’ll show you how to sync your favorite media files to your iPhone, 
iPad, or iPod exactly the way you want to. Read Sync. 

Rip CDs to your iTunes library: 
Learn to import music and audiobook CDs to your iTunes library and 
find key advice on the best formats and tags for your ripped tracks. 
Read Rip. 

Burn music and MP3 CDs: 
CDs are slowly going away, and fewer people use them for music these 
days. You may still want to burn CDs, however, to use in a car that 
doesn’t allow you to connect an iOS device, or to play on an old-fash-
ioned boom box. Read Burn. 

Print CD inserts and song listings: 
If you burn CDs, you can use iTunes to print inserts with album covers 
and song lists. You can also print lists of music in your iTunes library 
to take with you when you go CD hunting. Read Print. 

Back up your media files: 
No matter how you add content to your iTunes library, if you don’t 
back it up regularly, there’s a chance that you’ll lose it. Read Back Up. 

Extend iTunes with AppleScripts: 
iTunes does a lot; some people say it does too much. But you may 
want to go even further. If you use a Mac, you can take advantage 
of AppleScripts to extend iTunes. Read Bonus: Extend iTunes with 
AppleScripts. 
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What’s New in iTunes 12.5 
In iTunes 12.5, Apple did not change any core features or functions, 
though they made some interface changes and added a few new fea-
tures. Here’s an overview of what’s new. 

Interface changes: 
•	 Apple Music refresh: Apple Music has been refreshed with a

more legible and more easily navigable interface.

•	 New Library menu: If you hide the sidebar (View > Hide
Sidebar), the Library button in the navigation bar becomes a menu

, giving you quick access to items on your sidebar. Find out 
how this works in Hiding the Sidebar. 

•	 New Downloads preference pane: The download settings have
moved from the Store pane to a new Downloads pane. I discuss this
in How Can iTunes Automatically Download My Purchases?.

•	 Playlist icons in the sidebar: Playlist icons now contain badges
that indicate the media library in which they were created. See the
sidebar Identifying Playlists at a Glance.

•	 Quickly go to an artist’s recordings from Albums view: In
Albums View, when you click an album to expand its contents, the
artist’s name displays in blue. Click the artist’s name to see their
other music in Artists view.

•	 Simplified tag editing in Albums view and other grid
views: You can now edit tags, such as the name of an album or
artist, by clicking the text in Albums view. See the sidebar Quickly
Change Album and Artist Tags in Albums View.

•	 Quickly view an item in either the iTunes Store or Apple
Music: You can now Control-click a track and choose Go To to view
it in either the iTunes Store or Apple Music. Previously, you could
view it in the iTunes Store, but you had search in Apple Music.
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New features: 
•	 Dislike ratings: Apple introduced Love ratings a while ago;

they’ve now added Dislike ratings. Dislike ratings are primarily for
Apple Music’s recommendation algorithm, but you can use them
for your own music as well. See How Do I Tell Apple Music That I
Don’t Like Something? and Love/Dislike Ratings.

•	 Easier lyric display: You can now easily display lyrics during
playback (in the Up Next popover). If you’re an Apple Music sub-
scriber, iTunes can even automatically download lyrics, saving you
the trouble of entering them into iTunes manually. Learn more in
How Do I Sing Along with My Music?.

•	 Custom lyrics: Now that Apple Music can download and display
lyrics automatically, how do you work with manually added lyrics?
Read How Do I Add Lyrics to My Tracks? for the answer.

•	 Works and movements: New tagging options for classical music
let you define tracks as part of works, naming the work and its
individual movements. See Which Tags Make Classical Music Easier
to Manage?.
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Play 
Music is made for listening, and iTunes handles this task well. Shuffle 
and Genius help you enjoy music in different ways, and with Up Next 
you can queue your music for a listening session. 

You can play your media through other devices, and even control 
iTunes with Apple’s iTunes Remote app on an iOS device or an Apple 
Watch. 

The last two topics in this chapter look playing audiobooks and videos. 

Play Topics
 

How Do I Start Playing Music?
 

How Do I Play a CD? | Do I Have to Play Music in Order?
 

How Do I Shuffle My Music? | Can I Shuffle Albums?
 

How Do I Use the MiniPlayer?
 

How Do I Sing Along with My Music?
 

Can My Mac Tell Me What I’m Hearing?
 

What Is Genius? | How Do I Turn On Genius? | How Do I Create a
 

Genius Playlist? | How Do I Play Genius Mixes? | What Is Genius 

Shuffle?
 

How Do I Replay a Recent Song?
 

How Do I Use Up Next?
 

How Do I Make My Music Sound Better?
 

How Do I Play Media over a Network?
 

How Do I Control iTunes Remotely?
 

How Do I Display Eye Candy While Listening to Music?
 

Is There Anything Special to Know about Listening to Audiobooks?
 

How Do I Watch Videos in iTunes?
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How Do I Start Playing Music?
 

Playing media in iTunes is a lot like using a CD player (remember 
those?). Select the album, playlist, disc, or track that you want to hear 
and then click the Play button near the left of the toolbar (or any 
handy Play button; you may see more than one). The Play button in the 
toolbar becomes a Pause button that you can click to stop playing. 

Note: I talk about different ways you can view your music and 

playlists in View. See Search to learn how to find media directly,
 
without browsing.
 

To skip ahead one track, click the Next button; to skip back, click 
the Previous button. To scrub (skip) ahead or back within a track, 
press and hold one of these buttons or drag the playhead in the iTunes 
LCD, the status display at the top-center of the iTunes window, in the 
toolbar. And to change the volume, just drag the volume slider in the 
toolbar. 

Your iTunes library may contain a combination of tracks stored locally 
and in the cloud. If iTunes reaches a song in the cloud, it will stream 
the song; depending on your bandwidth, there may be a brief lag as 
iTunes starts pulling down the file. 

How Do I Play an Album? 
Generally, you start playing an album by clicking a Play button 
somewhere in the iTunes window. If you’re viewing an album that’s 
in your library, there are no play buttons to be seen, except on the 
toolbar. To see another Play button, hover over the album art or a 
track. Or, double-click a track to start listening to it. 

When you view an album in Apple Music, clicking the Play button 
in the iTunes toolbar does nothing (surely Apple will fix this bug soon). 
To play an album in Apple Music, hover over the album artwork to 
display a big blue Play button (Figure 2) and click it, or hover over 
the first track and click the Play button that displays to the left of it, 
or double-click the first track of the album. 
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Figure 2: There is no visible play button in Apple Music. iTunes 
displays one when you hover your pointer over album artwork. 

How Do I Play a Playlist? 
As with albums, you may find that the Play button on the toolbar 
doesn’t work and that there is no other Play button visible. To play a 
playlist—whether it’s on Apple Music or in your local library—you have 
two options: double-click the first track, or hover over the playlist’s 
artwork to see a Play button. 

At the time of this writing, hovering over playlist artwork for a locally 
stored playlist does not display a Play button, but for Apple Music 
it does. 

Beaming to the Currently Playing Track 
No matter what is playing in iTunes, and no matter where you are—
 

whether you’re looking at a different playlist, or a different part of
 
your library, or even the iTunes Store—you can always beam to the
 

track that’s currently being played, in the location where you chose
 

it (a playlist, your library, a CD, etc.), by pressing Command-L.
 

If you’re listening to music from Apple Music, this shortcut will take 
you to the appropriate Apple Music page. And if you’re listening to 
something in your Up Next queue, iTunes will take you to that track 
in your Music library, even if you added it to Up Next from a playlist. 
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Stream 
The world of music is changing. People are slowly shifting from owning 
their music—buying CDs or downloads—to renting it. With Apple 
Music and other streaming services, you can now access tens of mil-
lions of tracks for $10 a month. While not every artist or label’s music 
can be streamed, you can access most of what you want to hear. 

But is this the best way to spend your music budget? Some people— 
myself included—still buy CDs and still want to own music and listen 
on our own terms. In this chapter, I look at Apple Music and explain 
how it works, plus how you can find great music and help Apple Music 
recommend new music for you to discover. 

Note: Although Apple’s older iTunes Match service does stream
 

music, I chose to talk about it not in this chapter but instead in the
 

Cloud chapter.
 

Stream Topics
 

What Is Apple Music?
 

How Do I Turn On Apple Music?
 

How Do I Personalize For You?
 

How Can I Discover Music on Apple Music?
 

How Do I Love Music in Apple Music?
 

How Do I Tell Apple Music That I Don’t Like Something?
 

How Do I Stream from Apple Music?
 

How Do I Add Music from Apple Music to My Library?
 

How Do I Download Music for Offline Listening?
 

How Do I Delete Apple Music from My Library?
 

How Do I Listen to Apple Music Radio?
 

What about Internet Radio?
 

How Do I Use Connect?
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What Is Apple Music?
 

Apple Music is Apple’s streaming music service, which launched in 
2015. An Apple Music subscription combines several features: 

•	 Music streaming: You can stream more than 40 million tracks 
from the Apple Music Library. Much of the music that’s for sale in 
the iTunes Store is in this library, but not all. You can stream tracks 
on demand, such as a song or album, or you can stream playlists 
curated by Apple Music editors and contributors. See How Do I 
Stream from Apple Music?. 

•	 Cloud storage: You can store up to 100,000 tracks in your iCloud 
Music Library. If you enable iCloud Music Library, the music in 
your iTunes library is “matched” to the Apple Music Library, a pro-
cess that involves iTunes checking each track to see whether it 
matches a track that’s already in the Apple Music Library. If a track 
doesn’t match, it’s uploaded. These tracks show in your iCloud 
Music Library along with tracks you’ve purchased from the iTunes 
Store and those you’ve downloaded from Apple Music. See What Is 
iCloud Music Library?. 

•	 For You music recommendations: With 40 million tracks to 
choose from, you can have that kid-in-a-candy-store feeling, where 
you want to stream everything but don’t know where to start. Apple 
Music’s For You feature can help you choose what to listen to. See 
How Do I Personalize For You?. 

•	 Radio: Beats 1 is the marquee streaming radio station on Apple 
Music, but there are a few dozen others. You can also create an 
Apple Music Radio station from any song, artist, or genre. See How 
Do I Listen to Apple Music Radio?. 

•	 Connect: This is a sort of social network for music. If that sounds 
familiar, you may remember Ping, Apple’s earlier, failed attempt 
at connecting musicians and fans. Connect lets artists post music, 
videos, photos, and more. See How Do I Use Connect?. 
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An individual subscription costs $9.99 per month, and a family plan, 
available to groups using Apple’s Family Sharing, costs $14.99 per 
month for up to six people. (Prices are different outside of the United 
States.) 

If you don’t subscribe, you can access a subset of Apple Music features. 

Note: At the time of this writing, Apple Music offers 3-month free
 

trial memberships. The duration of the free trial may change over
 

time.
 

How Do I Turn On Apple Music?
 

To turn on Apple Music, follow these steps: 

1.	 Choose Music from the Media Picker, and then click the For You 
button in the navigation bar. 

2.	 Click Get 3 Months Free (or whatever option Apple happens to be 
offering), and follow the prompts. 

3.	 A lot of the benefit of Apple Music kicks in if you turn on iCloud 
Music Library. To learn about that, read What Is iCloud Music 
Library?, What Should I Know before I Turn On iCloud Music 
Library?, and How Do I Turn On iCloud Music Library?. 

Once you’ve turned on Apple Music, set up the For You recommenda-
tion feature, which I discuss next. 

How Do I Personalize For You?
 

You have your favorites, and you may want to start by listening to them 
right away. Or you may want to think back to music from years past 
and check out some of the tunes you grew up with. An advantage of 
being able to access more than 40 million tracks is the ability to listen 
to almost anything you want. But you can also discover new artists or 
composers with Apple Music’s For You recommendation service. 
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Cloud 
This chapter looks at the two major aspects of cloud-based iTunes use: 
the iTunes Store and iCloud Music Library. The iTunes Store keeps 
your purchased content in the cloud, so you can stream or re-download 
it at any time. iCloud Music Library is an evolution of iTunes Match, 
and it now works in conjunction with Apple Music to provide a cloud 
music library of up to 100,000 tracks that you can access from any 
computer running iTunes or any iOS device. 

Note: In the previous chapter, Stream, I answered a pile of ques-
tions about Apple Music, Apple’s streaming music service. Although
 

some of those answers touched on cloud-based aspects of Apple
 

Music, this chapter has information about iCloud Music Library.
 

Cloud Topics
 

Basics 
What Cloud Services Does iTunes Use?
 

How Can I Tell If My Media Is in the Cloud?
 

iTunes in the Cloud 
How Do I Re-download iTunes Store Content?
 

How Can I Hide Content I’ve Purchased from the iTunes Store?
 

iCloud Music Library Basics 
What Is iCloud Music Library? | What Is iTunes Match? | What Should I 

Know before I Turn On iCloud Music Library?
 

How Do I Start Using iTunes Match? | How Do I Turn On iCloud Music 

Library? | What Does iCloud Music Library Do with My Music Files?
 

How Do I Play Music in My iCloud Music Library? | How Do I Access My
 

iCloud Music Library in iOS? | How Do I Access My iCloud Music Library
 

on an Apple TV?
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More iCloud Music Library Questions 
How Does iCloud Music Library Handle Apple Lossless, AIFF, and WAV
 

Files?
 

Can I Use iCloud Music Library to “Upgrade” My Music?
 

What Do the iCloud Music Library Status Labels Mean?
 

How Do I Manage My Music with iCloud Music Library?
 

What If I Turn Off iCloud Music Library?
 

Can More Than One Person Share an Apple Music or iTunes Match
 

Account?
 

What Cloud Services Does iTunes Use?
 

In recent years, Apple has expanded its cloud-based media offerings. 
Here’s a quick look at the current options for digital media: 

•	 Automatic downloads: This feature has been around for a few 
years, so even though it’s cloud-based, you may not think of it that 
way. It lets you download a new iTunes Store purchase to more than 
one computer or device automatically. See How Can iTunes Auto-
matically Download My Purchases?. 

•	 Re-downloads: You can re-download an app or other media from 
the iTunes Store (assuming it’s still available) at any time. See How 
Do I Re-download iTunes Store Content?. 

•	 iCloud Music Library: Available to Apple Music and iTunes 
Match subscribers, iCloud Music Library commingles tracks from 
the following sources, making them available on all computers and 
mobile devices that are signed in to the same iTunes Store account: 

‣	 Tracks in your iTunes music library that didn’t come from Apple, 
such as tracks from CDs you’ve ripped, that are uploaded or 
matched through an iTunes Match or Apple Music subscription 

‣	 Music you’ve purchased from the iTunes Store 

‣	 Music you’ve added from Apple Music, as long as you maintain 
your Apple Music subscription 
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Before you start iTunes Match or turn on iCloud Music Library, 
read What Should I Know before I Turn On iCloud Music Library?. 

•	 Apple Music: This is the streaming arm of Apple’s cloud music 
offering. Without a subscription, you can listen to Beats 1, Apple’s 
radio station featuring real DJs, and access some aspects of Apple’s 
Connect social networking service. Subscribers can listen to Apple 
Music Radio, get a richer set of Connect features, gain access to the 
40 million tracks in the Apple Music Library, get For You recom-
mendations, and can turn on iCloud Music Library. See What Is 
Apple Music? to learn how to use this service. 

•	 iTunes Match: With iTunes Match, you use iCloud Music Library 
to store your music library in the cloud. The tunes that you store 
and access are only those from your library; you can’t access the 
Apple Music Library. Because iTunes Match is a subset of Apple 
Music, if you’ve subscribed to Apple Music, you won’t see an iTunes 
Match option. See What Is iTunes Match? for more. 

Note: Not all of these services are available in all countries. See 
Apple’s Availability article to find out what’s on offer for your country. 

How Can I Tell If My Media Is in the Cloud? 

A cloud icon indicates that a media item is currently stored in the 
cloud. For example, when iCloud Music Library is active, you may see 
cloud icons (Figure 33). You also see these icons on media from the 
iTunes Store that you’ve bought but not downloaded to your computer. 

Figure 33: The cloud icons at the bottom left of these album thumb-
nails tell me that some of their songs are not on my computer. 
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Share 
iTunes is designed not only to be used on its own, but also as a media 
hub for your home or office. This chapter looks at two iTunes features 
designed to let you share your iTunes library on a local network: Media 
Sharing and Home Sharing. 

Share Topics
 

How Do I Share My iTunes Library over a Network?
 

How Do I See a Shared iTunes Library?
 

Can I Create an iTunes Music Server?
 

How Do I Copy Media from One iTunes Library to Another?
 

How Do I Share My iTunes Library over a 
Network? 

iTunes lets you share your iTunes library in two ways: 

•	 Media Sharing: This method makes your media available to any 
computer running iTunes on your local network: within your home, 
office, or dorm. You can share your entire library or only certain 
types of media or certain playlists. And, you can password protect 
what you share so that only people with the password can access it. 

(An Apple support document calls this type of sharing “Music 
Sharing.” This moniker is incorrect, since you can share all the 
media content in your iTunes library, with the exception of Audible 
audiobooks. For this reason, I call the feature Media Sharing.) 

•	 Home Sharing: This method is designed to be used in a home, 
and lets your family members not only play your media, but also 
copy your files to their libraries. If you buy new music, or rip a new 
CD, others in your family can copy it to their libraries easily. Home 
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Sharing works not just on computers running iTunes, but also with 
iOS devices and Apple TVs that are on the same local network. 

Note: Both Media Sharing and Home Sharing are easy to use, but 
to read about other ways to share media, see How Can I Share My 
iTunes Store Content with Family Members?. Or, for music, consider 
a joint iTunes Match account. 

Using Media Sharing 
The simplest way to share your iTunes library is to use Media Sharing. 
Follow these steps to turn this feature on: 

1.	 In the General pane of the iTunes preferences, enter a name for 
your library in the Library Name field. iTunes adds one by default, 
but you might want to change it. 

2.	 Click Sharing in the toolbar to open the Sharing preference pane. 

3.	 Check the “Share my library on my local network” checkbox. 

4.	 Select a radio button to share your entire library or to share only 
certain playlists. 

5.	 If you want to share only certain playlists, select checkboxes for 
what you want to share. You can pick entire media libraries: Music, 
Movies, TV Shows, etc. You can therefore share, for example, only 
music, but not movies or podcasts, if you wish. But you can also 
choose to share any playlists you’ve created in your iTunes library. 

6.	 If you don’t want just anyone to access your library, check the “Re-
quire password” checkbox and enter a password. 

7.	 Click OK. 

Skip ahead to How Do I See a Shared iTunes Library? to learn how to 
view libraries using this method and how to play their content. 
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Note: While you can use Media Sharing to share your iTunes library, 
some other devices can also provide access to media files using a 
similar technology. For example, I have a network-attached storage 
(NAS) device with an “iTunes Server” feature that allows me to place 
music on the device and then access it like a shared library. This 
library, which you can see in Figure 37, below, acts like a Media 
Sharing library: I can play content, but I can’t copy it to another 
iTunes library. 

Activating Home Sharing 
To turn on Home Sharing, follow these steps: 

1.	 On each computer where you want to use Home Sharing, choose 
File > Home Sharing > Turn On Home Sharing. Enter the Apple ID 
and password associated with your iTunes account—on each com-
puter, you must enter the same Apple ID and password. 

2.	 Click Turn On Home Sharing. 

If you ever want to turn off Home Sharing, you can do so by choosing 
File > Home Sharing > Turn Off Home Sharing. 

To view and play the shared library, follow the steps in the next topic. 

Sign-in Error Message 
If you try signing in to a Home Sharing library and receive an error 
message about two-factor authentication—or a message about error 
5507, you will need to ask the account owner for the 6-digit code that 
Apple has sent to that person’s authentication device (probably an 
iPhone). 

Once you have the code, try logging in again, but this time append 
the code to the end of the password (if the password is frog and the 
code is 123456, type frog123456.) 

I expect that Apple will improve this inelegant technique in a future
 

upgrade to iTunes.
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Buy 
It’s easy to buy music online from a variety of vendors, but since the 
iTunes Store is an integral part of the iTunes program, I look at using 
the iTunes Store to add music, videos, and more to your iTunes library. 

The iTunes Store sells the following content in the United States: 
music, music videos, audiobooks, movies, TV shows, and apps (Win-
dows users can also buy ebooks through iTunes; Mac users now buy 
ebooks through the iBooks app). It also rents movies and is a gateway 
to free podcasts and free iTunes U lectures, videos, and PDFs. In other 
countries, the content available varies, but music and apps are sold in 
all countries where the iTunes Store is present. 

In this chapter, I focus on the U.S. iTunes Store. I also explain how to 
move digital content you’ve purchased elsewhere into iTunes, in How 
Do I Add Files I Own to iTunes?. 

Buy Topics
 

How Do I Shop in the iTunes Store?
 

Where Are My iTunes Store Purchases?
 

How Can iTunes Automatically Download My Purchases?
 

Which iTunes Store Content Has DRM?
 

How Can I Share My iTunes Store Content with Family Members?
 

How Do I Authorize and Deauthorize My Computer for iTunes Store
 

Purchases?
 

How Many iOS Devices Can Log In to My iTunes Store Account?
 

How Do I Manage Which iOS Devices Share My iTunes Store Account?
 

Why Buy Music If I Have an Apple Music Subscription?
 

How Do I Use the iTunes Store Efficiently?
 

How Do I Use the Wish List?
 

How Do I Add Files I Own to iTunes?
 

Can I Get Smarter with iTunes U?
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How Do I Shop in the iTunes Store?
 

To enter the iTunes Store, click the Store button in the navigation bar. 
The Store pane shows the type of media that’s chosen in the Media 
Picker—to shop for a different type of media, choose it from the Media 
Picker. 

To learn more about an item, or to buy it, click it to open its page. 
Pages for different types of media have different content: movies offer 
trailers, audiobooks let you listen to previews, and so on. 

When viewing an album’s page (Figure 39), you can preview a track 
by hovering over its track number and clicking, or you can preview the 
entire album by clicking “Preview All” beneath the track list. 

Figure 39: An album page in the iTunes Store. 

To buy an item, click its price directly. Notice that the price is part of 
a pop-up menu. Open the menu to give the item as a gift, tell a friend 
about it via email, add it to your Wish List, share it on Facebook or 
Twitter, and more. You’ll find that some music tracks are available only 
with full album purchases. In this case, there’s no price by the track, 
but rather “Album Only,” as you can see in Figure 39, above. In 
general, tracks longer than 10 minutes are album-only tracks. 
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If you ever have problems with purchases, you can contact iTunes 
Store support (there’s a link for that at the bottom of every iTunes 
Store window). 

To exit the Store, click a different button in the center of the navigation 
bar, or click the Back button at the left of the navigation bar—keep 
clicking until you back out of the Store. 

Where Are My iTunes Store Purchases?
 

iTunes Store purchases that you’ve downloaded appear just like any 
other media. For example, to see a downloaded song, click Music in the 
Media Picker, select Library in the navigation bar, and then click one of 
the views in the sidebar, such as Artists, Albums, or Songs. Or, type its 
title in the Search box at the upper right. Or, if you’ve just downloaded 
it, choose Music in the Media Picker, click Library, and select Recently 
Added at the top of the sidebar or view your Purchased or Recently 
Added playlist. 

For purchases that are not downloaded, see How Do I Re-download 
iTunes Store Content?, earlier. 

How Can iTunes Automatically Download 
My Purchases? 

Re-downloading is nice, but what is nicer is when new purchases 
download automatically to a different computer or iOS device. This 
means that when you buy a new album or app on your computer, it can 
automatically appear on your iPhone or iPad; and vice versa. 

For automatic downloads to occur, you need to turn them on. This is 
a good thing, because you may not always want automatic downloads. 
One particular case is when two spouses, for example, share an iTunes 
Store account. Alice may not want all of Bob’s purchases on her 
iPhone, and Bob may not want Alice’s new music on his Mac. 
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Podcasts 
The iTunes Store has an extraordinary selection of podcasts—from 
news to sports, music to philosophy, and more. Its vast catalog and its 
automatic downloads make it easy to follow your favorites. Read this 
chapter to learn how to sample, play, subscribe to, and manage pod-
casts. 

Podcasts Topics
 

How Do I Sample a Podcast?
 

How Do I Subscribe to a Podcast?
 

What about Alternative Podcast Apps?
 

How Do I Manage Podcasts?
 

How Should I Sync My Podcasts?
 

How Do I Sync Podcasts through My iTunes Store Account?
 

What Are Podcast Stations?
 

How Do I Create a Podcast Station?
 

How Do I Customize a Podcast Station?
 

How Do I Use Podcast Library Views?
 

Note: This chapter assumes that you are looking at your Podcasts 

library in iTunes in the default List view. If your view looks different,
 
sort yourself out in How Do I Use Podcast Library Views?.
 

How Do I Sample a Podcast?
 

Taking a podcast out for a test run is simple and a logical first step 
before committing to a subscription. 

To see the catalog of podcasts available, choose Podcasts in the Media 
Picker and then click Store on the navigation bar. The iTunes Store 
opens, showing its main podcast view. Look around to find a podcast 
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episode that interests you. (If aren’t sure what to try, check out The 
Next Track, shown in Figure 43, a podcast about how people listen 
to music today, which I host with Doug Adams.) 

Figure 43: Find podcasts to listen to in the iTunes Store. 

You can download an episode or stream it: 

•	 Download: Click the Get button to the right of its listing. (All pod-
casts are free, though it’s possible that, one day, there will be paid 
podcasts.) After the episode downloads, you can listen to it from 
iTunes even if you don’t have an Internet connection or sync it to an 
iOS device and listen to it with the Podcasts app. To find it, open the 
Media Picker and choose Podcasts, click Library on the navigation 
bar, and select Podcasts in the sidebar. Your download appears at 
the top of the podcasts list. 

•	 Stream: Hover over the name of an episode, and then click the 
Play button that displays to the left of its name. 
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How Do I Subscribe to a Podcast?
 

If you’ve sampled a podcast, as described just previously, and think 
you’ll want to listen to it regularly, you can simplify the download 
process by subscribing to it: 

•	 Subscribe from a downloaded episode: Control-click (right-
click) the episode’s listing in iTunes and choose Go To > Podcast in 
iTunes Store to view the podcast’s page in the iTunes Store. Then 
follow the instructions in the bullet item just below. 

•	 Subscribe from the iTunes Store: Find the podcast’s page in 
the iTunes Store, and then click the Subscribe button that’s just 
below its icon. This adds the podcast to your Podcasts library, and 
tells iTunes to check for new episodes as they are posted. Follow the 
directions in Choosing Update Settings for a Podcast, ahead shortly, 
to customize your subscription. 

Note: You can also stream or subscribe to podcasts from the
 

Podcasts app on any iOS device.
 

Subscribing to a Podcast That’s Not in the iTunes Store 
Some podcasters don’t list their shows in the iTunes Store. (Though 
not many; there’s little point in not being listed on iTunes.) You can 
still have iTunes subscribe to such podcasts, though, as long as you 
can find the URL for the subscription on the podcast’s Web site. Find 
it, copy it, and then, in iTunes, choose File > Subscribe to Podcast. 
Paste the URL and click OK. iTunes checks if the podcast is available, 
and, if so, adds it to your Podcasts library. You can now subscribe to 
it and listen to it as you would any other podcast. 
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Tag 
Tagging media files is the most important thing you can do to take 
control of your iTunes library. You could add all your music to your 
iTunes library and play it at random, but without correct tags, you’d 
never find what you want, and you wouldn’t be able to make smart 
playlists. To correctly organize your music, tagging is essential. 

In this chapter, I’ll show you which tags you can change, how to change 
them for single and multiple items, and how to streamline tagging so 
you can easily organize your library. (Note: I mostly discuss music 
here, but the methods of tagging are the same for all types of files.) 

Tag Topics
 

What Are Tags?
 

Where Is Tag Information Stored?
 

Which Tags Are Important?
 

How Do I Add or Change Tags?
 

Which Tags Should I Add or Change?
 

Which Tags Make Classical Music Easier to Manage?
 

What the Heck Is the Compilation Tag?
 

How Do I Put Files in the Correct Library?
 

How Do I Add Lyrics to My Tracks?
 

What Is Album Art?
 

How Do I Add Missing Album Art?
 

How Do I Rate Songs?
 

What Are Plays and Skips?
 

How Do I Reset My Plays or Skips?
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What Are Tags?
 

In order for iTunes to keep track of your media files, and for you to 
know which ones to play, every item in your iTunes library has tags. 
Tags are metadata—information about the files and their content— 
that helps iTunes sort tracks and keep albums together, tells iTunes 
what types of files they are, and more. 

At a minimum, for a song, you need a song name, artist, and album 
name. But you can add other tags: composer, year, genre, track num-
ber, disc number, and more. You can also tell iTunes how to play 
certain items and what types of content they contain (such as whether 
a video is a movie or TV show), and you can add comments, lyrics, and 
album artwork. 

To see tags for any item, select it and press Command-I. Here’s a list 
of the main tags for music, audiobooks, videos, and podcasts, and what 
they commonly contain: 

•	 Song (or Title for non-music files): The name could be a song 
name, the name of a movement in a symphony, a movie title, an 
audiobook title, and so on. 

•	 Artist: This is the person or group who recorded the music. For 
a movie, this tag is Director; for audiobooks, it’s Author. 

•	 Album: The name of the album on which the track appears, the 
title of an audiobook, or the name of a TV series. 

•	 Album Artist: Say you have a record by U2 with a song featuring 
Luciano Pavarotti. The artist tag would mention both of these 
artists, but the Album Artist tag would contain only U2, because 
the song is on a U2 album. This tag helps you sort music correctly 
by album, yet list additional artists on specific tracks. 

•	 Composer: The composer of the music, whether a classical com-
poser or a songwriter. 

•	 Grouping: Some music from the iTunes Store—usually classical 
music—has this tag. For example, an album that has three piano 
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concertos by Mozart will have a single name for the album, but the 
individual works’ names will be entered in the Grouping tag. You 
can sort files by grouping in iTunes, and you can use this tag with 
smart playlists. 

•	 Genre: You can pick from a number of preset genres, or you can 
add your own by typing one in this field. I’ve found that the Genre 
tag is a great way to organize my music. Because it’s easier to look at 
genres that contain less music, I’ve created plenty of non-standard 
genres. For example, I have genres for Dylan (Bob Dylan, and his 
recordings with The Band), Dead (The Grateful Dead, and its mem-
bers’ solo recordings), Lieder (German art songs), Chamber Music 
(string quartets, violin sonatas, etc.). 

Another way to set up fine-grained genres is to use multiple words, 
like Classical: Opera, or Blues: Electric. You’ll have all your genres 
grouped by the first word, with the sub-genre visible after it. 

You can also set genres for movies, TV shows, and audiobooks, in 
order to sort and organize them more efficiently. 

•	 Year: The year the music was recorded, performed, or released, the 
year a movie was made, or the year a podcast was produced. 

•	 Track Number and Disc Number: These should be self-
explanatory. 

•	 BPM: Beats per minute; useful for DJs or others who want to 
organize music by tempo. 

•	 Comments: You can put anything you want in this field; you may 
want to enter specific information to help with smart playlists. For 
example, my Bob Dylan live albums have “live” in the Comments 
tag, so I can make a smart playlist of Dylan’s live songs. Note that 
this field holds only 255 characters. 

•	 Compilation: Selecting Album Is a Compilation of Songs by 
Various Artists tells iTunes to group the song with other songs in 
the same album that are also tagged as a compilation, even if those 
songs are by different artists. 
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View 
You’ve ripped and bought music and videos, and you’ve tagged your 
files. Now you need to choose the right way to view your burgeoning 
media library so you can find what you want to listen to easily. 

In this chapter, I’ll show you various ways to arrange iTunes to display 
your media files, which is the first step to getting access to your ever-
growing media library. 

View Topics
 

How Do I Use the Sidebar?
 

What Are Those Buttons in the Middle of the Navigation Bar?
 

How Can I View My Music Library?
 

How Do I Use Podcast Library Views?
 

How Do I Show Columns in List Views?
 

What Can I Do with Contextual Menus?
 

How Do I Use the Sidebar?
 

The iTunes sidebar, which displays at the left of the app’s window, 
helps you navigate within your various media libraries. If you don’t see 
the sidebar at the left of your iTunes window, click the Library button 
in the center of the navigation bar. If the sidebar is still not visible, 
choose View > Show Sidebar. 

The sidebar lets you view your media libraries in different ways. For 
example, in Figure 57, I’ve selected the Music library, and the sidebar 
lets me view my Artists, Albums, Songs, Genres, and more. 
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Figure 57: Use the sidebar to choose the way you view the contents 
of the selected media library. 

Switching to a Different Library 
Above the sidebar is the Media Picker. This menu lets you choose 
which media library you view. If you want to view your Music library, 
choose Music; if you want to view podcasts, choose Podcasts. You can 
also choose a shared library from this menu (see How Do I Share My 
iTunes Library over a Network?). 

You can eschew the Media Picker entirely and switch libraries from 
the keyboard. If you press Command-1, iTunes displays your Music 
library. Command-2 shows the Movies library. Command-3 displays 
the TV Shows library. You can see all these keyboard shortcuts in the 
View > Media Kind submenu. 

Ebooks note: For Mac users, the Books library has been replaced 

with the Audiobooks library (see Where Have My Ebooks Gone?).
 

Customizing the Media Picker 
You can edit the Media Picker menu to slim it down or to expand its 
offerings. Open the Media Picker and choose Edit Menu. Select or 
deselect items you want to see in the Media Picker (Figure 58). When 
you’re finished, click Done to save your changes. 
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Figure 58: You can slim down the Media Picker menu, removing 
the types of media you don’t use. 

Viewing Media from the Sidebar 
At the top of the sidebar, you can choose how you view your media. In 
Figure 59, you can see the default options for the Music library. 

Figure 59: By default, the sidebar for the Music library offers 
a variety of views. 

Click a view in the sidebar—Artists, Albums, etc.—to see your Music 
library in the main pane of the window with a focus on that element. 
(I explain these views below, in How Can I View My Music Library?.) 

Below the Library section, you’ll see several entries: 

•	 iOS devices: If you connect an iOS device to your computer, or 
if you use Wi-Fi syncing for your iOS device, you’ll see it under 
Devices, just below the Library section. Clicking the device’s icon 
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Organize 
You’ve got your favorite media in your iTunes library, but you’d like 
to organize it better. In this chapter, I’ll show you how to make play-
lists, the key to setting up your listening sessions. I’ll look at using tags 
to create playlists automatically with your favorite tunes. I also cover 
some special topics that will help you with tasks like finding your 
media files on your disk and managing a large iTunes library. 

Organize Topics
 

Playlists 
On Playlists
 

How Do I Make a Standard Playlist? | How Can I Share Playlists? |
 

What Can I Do with a Playlist?
 

What Are Smart Playlists? | How Do I Create a Smart Playlist? | What 

Interesting Things Can I Do with Smart Playlists? | Do Smart Playlists 

Slow Down iTunes?
 

How Can I Organize My Playlists?
 

Special Questions 
How Do I Delete Songs from My Library?
 

How Does iTunes Organize My Files?
 

Where Have My Ebooks Gone?
 

Where Can I Put My Media If I Run Out of Room on My Computer?
 

How Do I Move an iTunes Library from a Windows PC to a Mac?
 

What’s the Best Way to Deal with My Huge Music Library?
 

Can I Have More than One iTunes Library on My Computer?
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On Playlists
 

You can listen to your music by album, or by selecting song after song. 
You can play all the music by a specific artist, or you can shuffle your 
entire library. But iTunes reveals its biggest strength when you make 
playlists. 

A playlist is a list of songs that you play together, one after the other, 
with a first song and a last song. Pretty basic; kind of like a CD. 

But playlists are more than that. A playlist is a self-contained unit, one 
with a bunch of tracks you can always play in order or in Shuffle mode; 
a group of songs that you can listen to while dining or when chilling 
outside; or your favorite lively songs to listen to when you work out. 

A playlist can be the equivalent of an album, a double-album set, a 
live concert, or an opera. It can be a compilation of favorite songs by 
different groups, or a selection of music for a special occasion. It can 
even contain all your songs, if you want. With smart playlists, you can 
create endless playlists that keep adding music as you listen. And a 
playlist can even include videos and podcasts. 

Let’s distinguish between two types of playlists: 

•	 Standard: Standard playlists are groups of songs (or other media) 
that you organize manually. The key word here is manually: as 
you’ll see ahead, smart playlists are automatically created from 
conditions you select, but standard playlists require that you choose 
every track they contain, and their play order. Standard playlists are 
also static; they don’t change as you play them, unless you intervene 
or play them in Shuffle mode. 

•	 Smart: Smart playlists are dynamic. You choose conditions, and 
iTunes scans your library for files that match these conditions, 
based on the tags your files contain. (Hence the importance of tag-
ging your media correctly.) In essence, the conditions in a smart 
playlist tell iTunes to search your library for items that match them. 
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How Do I Make a Standard Playlist?
 

You create a standard playlist by choosing File > New > Playlist, or 
pressing Command-N. iTunes adds the playlist to the sidebar, and 
highlights its name. By default, iTunes names the new playlist Playlist 
(or, if that name exists, Playlist 2, and so on). Type a name for the 
playlist, and then press Return to save the name. 

It is possible to create multiple playlists with the same name. Try to 
give your playlists unique names so you can tell them apart. To later 
change the name of a playlist, find it in the Playlists sidebar, click it, 
wait a moment, click it again, and type a new name. 

Click the new playlist in the sidebar to work with it (Figure 74). 

Figure 74: Here’s a new playlist waiting to be filled with music. 

Tip: To create a new playlist that already contains some music, start 
by selecting some tracks in your iTunes library, in any view. These 
may be an album or two, all of an artist’s music, or some disparate 
tracks you’ve selected by clicking the first, then Command-clicking 
others. Next, choose File > New > Playlist from Selection. iTunes 
creates a new playlist with the selected tracks. 
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Search 
The larger your iTunes library, the harder it is to find what you’re 
looking for. Although there are ways to view your content by Artist, 
Genre, or other criteria, sometimes you want to find a specific song, 
album, or movie quickly. In this chapter, you’ll learn how to search 
in iTunes, in both the app’s main window and its MiniPlayer. I’ll also 
explain how to tidy your library by weeding out duplicates. 

Search Topics
 

How Do I Search in My Library?
 

How Do I Search from the MiniPlayer?
 

Can I Search by Star Rating?
 

How Do I Find Duplicates in My Library?
 

How Do I Search in My Library?
 

iTunes has a Search box at the top right of its window. By default, 
iTunes searches your entire library, but it can also find items in the 
specific library you are currently viewing (Music, Movies, TV Shows, 
etc.). I explain each option next. 

Searching Your Entire iTunes Library 
By default, iTunes searches your entire library. Type your search terms 
in the Search box, and iTunes returns a list of hits grouped by category, 
similar to the way the Mac’s Spotlight displays search results. Each 
section of the results list has no more than four items. If there are 
more than four, to see the rest, click the “More” text, such as “show 567 
more” in Songs, shown in Figure 82. 
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Figure 82: Search results in the above example are grouped by 
Songs, Artists, and more. Searches can also turn up results from 
playlists, and other types of media, such as Movies or Podcasts. 

You can hover over an item in this list to see controls. For example, you 
can add a song to the Up Next queue by hovering over it and clicking 
the Add to Up Next icon at the left of a track (see How Do I Use Up 
Next?). Or click the More icon at the right of a track, to choose a 
number of options. You can also drag a song from the results to a 
playlist (described in How Do I Make a Standard Playlist?). 

Filtering a Search 
If your search returns a lot of results, the Search popover isn’t especial-
ly efficient to work with. To see all your results in the current iTunes 
view, click the blue Filter label at the top of the popover (in the figure 
above, this label reads Filter Music for “ives”). 

Alternatively, to dig a little deeper, you can search within a library, as 
I describe next. 
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Searching within a Specific Library 
To search a specific library, choose it from the Media Picker. Then, 
in the Search box, click the magnifying glass icon to open a menu 
and choose Search Entire Library to de-select it. 

Specific library searches are live searches that filter the content dis-
played in the current view. You see only items that match your search; 
other items are temporarily hidden. 

You can limit searches to different tags by clicking the magnifying 
glass icon in the Search box and choosing a Filter By option. These 
options change according to the type of content you’re viewing. For 
example, with Music you can search for All, Song, Album, Artist, or 
Composer, whereas with TV Shows you can search for All, Title or 
Show. All means that iTunes should search in all the tags (with the 
exception of texts you’ve added to the Comments and Lyrics fields). 

Searching in a Playlist 
You can search in regular playlists and smart playlists, just as you
 

do in libraries. To hunt for items in a playlist, first view the playlist.
 
Then, click in the Search box and enter your search terms.
 

How Do I Search from the MiniPlayer?
 

If you use the MiniPlayer, described in How Do I Use the MiniPlayer?, 
you can search without switching to the main iTunes window. Click the 
Search button near the right of the MiniPlayer window. A Search 
box appears. Enter the text you want to find in the field. Click Cancel to 
return to the default MiniPlayer view. 

Searching with the MiniPlayer searches only your Music library. You 
can perform the same actions on search results—play items, add them 
to Up Next, etc.—as described earlier in this chapter. 
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Sync 
If you have an iOS device, iTunes is the tool you’ll use to sync your 
media files to it, along with apps and other information. The way you 
set up your media library in iTunes reflects how these files become 
accessible on your portable device. 

Syncing offers many options. I want to point out some of the basics, 
and explain how you can put your favorite media files on your iOS 
device. As with the rest of this book, my focus here is music and videos. 
Once you grasp the concepts, it’s simple to sync your media to your 
iOS device exactly the way you want to. 

Note: If you’ve turned on iCloud Music Library on your iOS device, 
you can’t sync music to the device; instead, you must download your 
music from the cloud. The options described below will still apply for 
other types of content. See Cloud for more on working with iCloud 
Music Library. 

Sync Topics
 

What Should I Sync to My iOS Device?
 

How Do I Connect My Device to iTunes?
 

How Do I Sync My Content?
 

How Do I Sync This Ebook?
 

How Do I Squeeze as Much Music as Possible on My iOS Device?
 

Can I Have iTunes Fill My iOS Device?
 

How Can Multiple People Sync iOS Devices with the Same Computer?
 

How Do I Put Music on an Apple Watch?
 

What about Syncing an Apple TV?
 

Are There Special Features for Syncing an iPod shuffle?
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What Should I Sync to My iOS Device?
 

Before thinking about what you want to sync, take a minute to consider 
what you can’t sync through iTunes: 

•	 If you’ve turned on iCloud Music Library, you no longer copy music 
through iTunes. 

•	 It’s the same with iCloud Photo Library—if you’ve turned it on, you 
no longer sync photos through iTunes. 

•	 If you’ve turned on iCloud sync for calendars or contacts, you can’t 
sync that data through iTunes. 

For items that you can sync, you may wish to transfer them in some 
other way. For example, on an iPhone, you may prefer to download 
iTunes Store purchases from the cloud and podcasts can all come over 
the air. However, you’ll be able to add new content to the device only 
when it has an Internet connection. In the case of a cellular connec-
tion, if your data plan is limited or the connection is slow, you may find 
that you can’t get the items you want when you need them. And, of 
course, cellular works only for cellular devices, such as an iPhone or an 
iPad with cellular access. 

Another part of thinking about what to sync has to do with your de-
vice’s capacity for holding media: 

•	 Your device has the capacity to hold all your media: In 
this case, sync it all; it’ll be much easier for you to not worry about 
choosing specific items. This will be the case if you have a 160 GB 
iPod classic, for example (may it rest in peace), and less than 160 
GB of media (well, 149 GB to be precise; that old my-bytes-aren’t-
the-same-as-your-bytes thing). Or if you have a 64 GB iPhone, and 
have, say, 20 GB of music and a few GB of videos. 

Unless you really don’t want your videos on the device, then don’t 
worry, sync everything and be happy. 

•	 Your device doesn’t have space for all your media: In this 
common situation, you need to choose what to sync. Your choice 
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isn’t permanent; you can change what you sync every week, or even 
every day. You can have certain types of items sync dynamically: 
for example, you can sync only unwatched TV shows or unplayed 
podcasts, or only a certain number of them. In this way, your iOS 
device’s content will change as you watch TV shows or listen to 
podcasts. You can also use smart playlists to change the music that 
you sync: for example, you can sync only music you haven’t listened 
to recently, or only music you’ve bought in the last few months. 

Many people fall into the second camp, but generally because of the 
videos in their iTunes libraries, not audio. In that situation, you may 
want to sync all your music, and pay more attention to choosing which, 
if any, videos you sync to your device. 

How Do I Connect My Device to iTunes?
 

Initially, you’ll connect your device with a USB cable. You can continue 
to connect with USB, or if your device supports it, you can set up a Wi-
Fi connection (see the sidebar Wi-Fi or USB Cable?, ahead slightly). 

Once you’ve made the connection, to see your device in iTunes, select it 
on the navigation bar (or click the Devices button on the navigation bar 
and then select it). 

About the Devices Button 
Found in the navigation bar to the right of the Media Picker, this 

button displays the shape of the last device that made a connection
 

to iTunes, but doesn’t indicate how many devices are connected.
 
Click the button to access a single device or to display a popover
 

where you can choose a device if more than one are connected.
 

The items in the sidebar change. You can now click an item in the 
Settings section in order to view a pane related to managing or syncing 
your device. Most of the panes relate to a specific type of media, but 
the Summary pane, which is selected in the sidebar in Figure 83, 
contains housekeeping options, such as whether you need to update 
your device’s operating system and options for backing up your device. 
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Rip 
When you first launch iTunes, its library is empty. When you rip, or 
import, a music CD, you add the music to the library. You can then 
listen to it on your computer or sync it to your iOS device. But you can 
add more than just ripped music: you can rip audiobooks from CDs or 
add videos from DVDs that you own. 

Rip Topics
 

How Should I Rip My CDs?
 

Which Compression Format Should I Use to Rip CDs?
 

Which Bit Rate Should I Use to Rip CDs?
 

What Other Settings Are Important When Ripping CDs?
 

How Do I Rip a Music CD?
 

How Do I Rip an Audiobook CD?
 

How Do I Convert Audio Files to a Different Format?
 

How Do I Rip Videos to Use in iTunes?
 

Why Won’t My Video Sync?
 

Can I Rip Just the Music from a Concert DVD?
 

How Should I Rip My CDs?
 

Many music lovers still buy CDs. These plastic discs offer several 
advantages over digital music: they contain uncompressed music; 
they have liner notes; and, in some cases, they are cheaper than digital 
downloads. You can pick up used CDs for a few bucks each, and you 
can get many excellent box sets of classical music for just a couple of 
dollars per disc. 

Ripping CDs is simple, but you should make some decisions regarding 
compression format, bit rate, and tagging before you start. If you have 
a large music library, you’ve probably already made these decisions, 
but if you’re still building your library, it’s not too late. You can re-rip 
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CDs you’ve ripped in the past, if you decide that you’d rather use a dif-
ferent bit rate. But also consider how much your music library is going 
to grow. If you have lots of CDs that you haven’t yet ripped, or if you 
buy a lot of music, plan ahead. Keep reading to find advice on each of 
these topics. 

Note: The following topics on compression formats, bit rates, etc., 
may seem complex, but the quality of your ripped music depends on 
them. You’ll need to read these topics only once; after you’ve chosen 
your settings, you’ll probably never want to change them. 

Is Ripping Legal? 
If you’re used to ripping CDs, you’d probably never think that it 
might not be legal to rip them. In the United States, and in many 
other countries, ripping music is legal as part of the “fair use” doc-
trine of copyright law, as long as you rip CDs that you own, and the 
digital files are for your personal use only. You can’t rip a CD, then 
make mixes and give them to your friends. 

Later in this chapter, I’ll talk about ripping DVDs, which, according 
to current U.S. law, violates the DMCA (Digital Millennium Copyright 
Act). This is because DVDs are, in most cases, protected by encryp-
tion called CSS (Content Scrambling System). Bypassing any such 
copyright protection system is illegal. (In 2010, exemptions were 
made to the DMCA for noncommercial copying of short excerpts for 
the purpose of criticism or comment.) 

However, there is a gray area around copying DVDs that you own 
in order to view their content on an iOS device, laptop, or Apple TV; 
it’s essentially the same as ripping music to listen to on your iPod. 
I am not espousing the violation of any law, merely presenting meth-
ods that are used to create digital versions of videos on DVDs. It’s up 
to you to decide how to deal with the legality of the procedure. 

223
 

Click here to buy the full 260-page “Take Control of iTunes 12: The FAQ, Second Edition” for only $15!

https://www.takecontrolbooks.com/cart?add-to-cart=1192


      

           
          

             
           
                

          

          
         

              
        

           
            

             
         

             
       

             
          

          
          

              
    

             
           

         
          

            
           
             

           
          

Which Compression Format Should I Use 
to Rip CDs? 

Before getting our hands dirty with actual CD rips, I want to discuss 
compression formats. When you rip a CD with iTunes, you can either 
use iTunes’ default format or choose a different one that suits you. To 
make this choice, you need to understand a bit about compression. 
(Skip ahead to How Do I Rip a Music CD? if you don’t care and want 
to use the default, or if you already know this stuff.) 

Compression is a seemingly magical function that reduces the size 
of digital files. You’ve probably used compressed .zip archives, which 
allow you to store data in smaller files or to transfer data over a net-
work more effectively. Compression software looks for redundancies 
in bits of data, especially repeated characters or series of characters, 
and replaces them with shorter bits of data. You can compress text files 
to about half or one-third of their original size, and some graphic files 
can be compressed to less than one-tenth of their full size. 

When you compress some kinds of files, such as text files or apps, you 
need to use lossless compression—this means that after you decom-
press the files you have exactly the same data you started with. While 
there are lossless compression formats for music, the most popular 
compression schemes are lossy, and they save space by removing 
certain data that is deemed unessential. For this reason, compressed 
music in lossy formats contains less data and is never as good as the 
original music on your CDs. 

Or is it? In blind tests, most people can’t tell the difference between 
music compressed at a high-enough bit rate and original CDs. In fact, 
only those with audiophile equipment are likely to notice any differ-
ences. In most cases, home stereos are good-but-not-great, and what’s 
lost in compression won’t be noticed. If you’re ripping music for a 
portable device, you won’t hear much of a difference because of the 
ambient noise around you. You might want to do a test yourself; read 
my article Can You Really Tell the Difference Between Music at Differ-
ent Bit Rates? to see how to carry out this test. 
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Burn 
We’ve looked at a lot of iTunes features so far, and this one seems 
obvious: you can use iTunes to burn CDs, thus copying audio files to 
disc. But CDs are slowly going the way of the floppy disk, and fewer 
people use them for music these days. You may still want to burn CDs, 
however, to use in a car that doesn’t have a way for you to connect an 
iOS device. It’s simple to do this with iTunes, so read on and find out 
how. 

Burn Topics
 

How Do I Burn CDs of My Music?
 

What Music Won’t Burn?
 

Can I Burn DVDs of Videos?
 

How Do I Burn CDs of My Music?
 

This is easy: 

1.	 Make a playlist (flip back to Organize if you need help). If you want 
to fit the playlist on a single CD, check the status bar at the bottom 
of the iTunes window. (To display the status bar, choose View > 
Show Status Bar.) 

‣	 For a normal audio CD: For an 80-minute CD, keep your time to 
a bit less than 80 minutes; if you have a 74-minute CD, stay a bit 
under that duration. 

‣	 For an MP3 CD: If you have a car stereo, for instance, that can 
play an MP3 CD, you might use this type of CD and thus be able 
to include more tunes. Look at the amount of data, not the time. 

2.	 Choose File > Burn Playlist to Disc. 
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3.	 In the Burn Settings dialog that displays, you can set a few options: 

‣	 In general, the preferred speed should be Maximum Possible, 
unless you know that your CDs don’t burn well above a certain 
speed. 

‣	 The disc format in most cases should be audio CD, but obviously 
you can select MP3 if desired. 

‣	 The gap between songs setting is 2 seconds by default; change 
this only if you’re burning a “gapless album,” such as a live album 
with segues. 

4.	 Click the Burn button. 

5.	 Slip a CD into your burner, and wait. 

What Music Won’t Burn?
 

Music purchased from the iTunes Store back when there was DRM can 
be burned from a single playlist only seven times. If you want to burn it 
more times, you need to delete the playlist and recreate it. 

Also, iTunes won’t burn MP3 CDs of music with DRM, including music 
you’ve added to your library from Apple Music. 

If you have iTunes Plus music—without DRM—or music that you’ve 
ripped from CDs or purchased from other vendors, these limitations 
don’t apply. 

Can I Burn DVDs of Videos?
 

Not with iTunes. And not with any content you’ve bought from the 
iTunes Store no matter what software you use. It’s too bad, because, 
personally, I won’t buy videos from the iTunes Store for that very 
reason. If I plan to buy a TV series, for instance, and can’t put it on 
DVD, that means I’m tied to my computer, Apple TV, or iOS for play-
back. 
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Print 
Printing from iTunes is probably not the first thing you’d want to do 
with the program. But this feature can be useful: if you burn CDs, you 
can use iTunes to print inserts with album covers and song lists. You 
can also print lists of music in your iTunes library, by album or as a list 
of albums. Why would you want to do this? Read on… 

Print Topics
 

Why Would I Want to Print from iTunes? 

What Can I Print with iTunes? 

Why Would I Want to Print from iTunes?
 

Well, if you burn CDs, you might want jewel case inserts to make them 
look nice, especially if they’re intended to be gifts. The song listings 
and album listings may be useful if you’re a collector and want a hard-
copy to take with you when you go CD hunting. 

Or you may want a hard copy of the contents of your iTunes library, 
just because. 

What Can I Print with iTunes?
 

iTunes can print a number of documents from information in your 
iTunes library. To access the printing feature, select a library or playlist 
in the sidebar, or an artist, album, composer, or genre in any view (see 
Basics), and choose File > Print to open the Print dialog (Figure 96). 
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Figure 96: The iTunes Print dialog can display a preview of a list of 
albums, including album art and a complete list of their contents. 

You can print the following: 

•	 CD jewel case inserts: You can print these with a theme in black 
and white or in color, and you can choose from text only, a mosaic 
of album covers (for playlists featuring music from multiple 
albums), or a single cover. 

•	 Song listings: These lists are dumps of your iTunes library data, 
and contain such information as song name, time, artist, and 
album. You can add more information to your list by choosing a 
theme for your list—user ratings, dates played, or custom. Custom 
prints whatever columns are currently visible in your iTunes library 
or playlist. 

•	 Album listings: These are either lists of songs by album, including 
album art, or lists of all your albums. 

Note: Learn more about printing in my Macworld article Printing from 
iTunes. The article is a bit old, but nothing important has changed 
with this feature in over a decade! 
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Back Up 
No matter how you add content to your iTunes library—whether you 
rip your own CDs and DVDs or buy music and videos from the iTunes 
Store or from other vendors—this content is as ephemeral as all digital 
files. If you don’t back it up regularly, there’s a chance that you’ll lose 
it. While this is less of a problem for CDs you’ve ripped, since you can 
always rip them again, think of the amount of time you’d have to spend 
to re-rip and re-tag your CDs. Backing up media files is as important as 
backing up all the other files you have on your computer. 

What’s the Best Way to Back Up 
Media Files? 

iTunes used to offer a Backup feature, whereby you could back up 
various parts of your iTunes library. But when Apple began allowing 
users to re-download much of their purchased content, the Backup 
feature was removed. This is a shame, since most users have content 
not purchased from the iTunes Store and since some iTunes Store 
content is not available for re-download. And if you are using iTunes 
Match or Apple Music, it’s not safe to assume that all your music will 
be available from the cloud. 

You can use any of a number of backup programs to back up your data 
locally to an external disk or DVDs. If you are using a Macintosh, you 
can use Time Machine, which is a feature of macOS. 

However, all manner of catastrophes can happen, so a local backup 
may not be enough. If you live in California or Japan, you know that 
the ground moves occasionally. Excessive rain may flood your home. 
And in the U.S. state of Kansas, your computer could be taken to Oz 
without warning. For this reason, you should consider keeping a back-
up of your media collection—if it’s as important to you as mine is to 
me—in an off-site location. And I don’t mean in the house next door, 
but, perhaps, at a friend’s or relative’s house a fair distance away, or 
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in a safe deposit box in a bank. You can rotate the backups regularly— 
every few months, for example, if you have to mail the hard disks, or 
monthly, if it’s nearby—so you can always have a backup that’s more-
or-less up to date. 

Also, if you have the bandwidth, consider an online backup service 
such as CrashPlan or Backblaze. 

I recommend that you read Joe Kissell’s Backing Up Your Mac: A Joe 
On Tech Guide for information about making effective backups. Also, 
see my Macworld article Back up your iTunes media files. 

In any case, I urge you to back up your iTunes library regularly. While 
you can re-download some of your purchased content from the iTunes 
Store, if, like me, you have spent a lot of time ripping and tagging CDs, 
losing those files would be terrible. 

Tip: If you’ve researched how a Drobo works and decided on a Drobo 
device as part of your backup solution, don’t miss the 10% off Drobo 
Coupon at the back of this book. 

How I Back Up My Media Files 
I’m a backup fundamentalist. I believe that backups are essential. 
There’s no doubt that one day you’ll lose data: your disk will fail, your 
computer will be lost or stolen, or it will be accidentally damaged. I’m 
even a belt-and-suspenders guy; I back up my backups. 

My media files are vital to me. I’ve spent thousands of hours ripping 
CDs, tagging music files, adding album art, and managing my library. 
I currently keep my media files on a 4 TB external hard drive. I use 
Time Machine, with two alternating hard drives, to back up my iTunes 
library (but not my purchased videos). I also make regular backups 
of my full media library to two 4 TB hard disks, and an occasional 
backup to a third 4 TB drive. These backups all run daily, automati-
cally. Should my main hard disk fail, I have four backups of all my 
files. The odds of both the main hard disk and the backup drives 
failing are astronomically slim. 

If your media files are as important to you as they are to me, consid-
er using a similar strategy. Just in case. 
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Bonus: Extend iTunes with 
AppleScripts 

iTunes does a lot; some people say it does too much. As this book has 
shown, many of those features are easy to tame, but at times you may 
want to go even further. 

If you use a Mac, you can take advantage of AppleScripts to extend 
iTunes. While looking at AppleScripts in depth would take another 
book of this length, in this bonus chapter I want to give you a taste 
of what AppleScripts can do for you, and tell you about some of my 
favorite AppleScripts. 

Bonus Topics
 

What Are AppleScripts?
 

Where Do I Get AppleScripts?
 

What Can I Do with AppleScripts?
 

What If I Use Windows? How Can I Do All These Great Things?
 

What Are AppleScripts?
 

AppleScript is a scripting language that Apple developed for the 
Macintosh operating system in the early 1990s. It was first available 
on System 7.1.1, and it offers a way to take advantage of system func-
tions via AppleScripts, short programs that are much easier to write 
than full-fledged applications. 

AppleScript works with much more than just the operating system: 
many Apple programs (the Finder, iTunes, Photos, Safari, Mail, etc.) 
and third-party applications (Microsoft Office, Adobe Creative Suite, 
etc.) support AppleScript to some extent. 
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AppleScript support can be limited—supporting a mere handful of 
commands—to complex. iTunes offers in-depth scriptability, notably 
by providing access via AppleScript to the tags in your media files. 

When you add AppleScripts to your user folder at ~/Library/iTunes/ 
Scripts, they display in a Scripts menu in iTunes, and you can run 
them by choosing them. (If you don’t have that folder, you can create 
it when you add your first AppleScript.) 

Tip: The ~/Library folder mentioned in the previous paragraph is 
normally invisible. To see it, hold down the Option key and choose 
Go > Library in the Finder. 

Where Do I Get AppleScripts?
 

There are two ways to get AppleScripts. The first is to roll your own, 
but, to be fair, this requires a good knowledge of programming. While 
Apple claimed—and still claims—that AppleScript is close to natural 
language, this isn’t exactly the case. (For more about the technical 
aspects of AppleScript, check out Apple’s AppleScript hub on their 
developer site.) 

There’s an easier way to get AppleScripts for iTunes. Go to the Doug’s 
AppleScripts for iTunes Web site. Run by Doug Adams, AppleScript 
guru extraordinaire, this site is a compendium of scripts that he has 
written and that others have submitted. There are scripts for managing 
tracks and track info, working with artwork, dealing with playlists, 
controlling iTunes, importing and exporting information about your 
iTunes library and playlists, managing files, working with libraries, and 
much more. As of this writing, the site houses 465 scripts and a hand-
ful of applications that Doug has written. 
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What Can I Do with AppleScripts?
 

If I said “just about anything” I’d be exaggerating; but not by much. 
When you see exactly what AppleScripts can do with iTunes, you may 
be surprised. I use them most often for tagging files; copying, correct-
ing, truncating or appending track names; searching for and replacing 
text; finding “missing” tracks in my library; and changing hidden 
preferences. 

But the best way to understand what AppleScripts can do is to look at 
some concrete examples. Here are my top ten AppleScripts, with links 
to them on the Doug’s AppleScript for iTunes Web site: 

1.	 Remove n Characters from Front or Back: This script lets you 
remove extraneous characters from the beginning or end of a tag. 
You can do this for tags including Name, Album, Artist, and Com-
poser. I use it often for classical music; many Name tags include the 
name of the composer before the name of the track, in this form: 
Schubert: Gute Nacht. For an album tagged like that, I remove the 
first ten characters, and keep just the name of the track. 

2.	 Copy Tag Info Tracks to Tracks: With this script, I copy, say, all the 
track names from a classical album and paste them on the tracks of 
another recording of the same work. It’s a real time saver. You can 
copy the name, artist, album, composer, genre, artwork, and even 
dynamic tags such as last played date and rating. 

3.	 Super Remove Dead Tracks: Have you ever moved files around and 
then found that some of your tracks show up with a ! in iTunes? 
These “dead tracks” mean that you removed the original files, but 
not their entries in your iTunes library. Find them and remove them 
easily. 

4.	 Tracks Without Artwork to Playlist (found in TrackSift 2): I’m 
a stickler for adding album art to my tracks, so I have visual re-
minders of my music. I used this script a lot when I was going 
through the process of adding artwork. It creates a playlist for all 
the tracks in your library that have no artwork so you can search 
for graphics and add them to your music. 
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Learn More 
Here’s a list of some of the most useful Web sites for learning more 
about iTunes and iOS devices: 

•	 Kirkville: This is my personal Web site. I regularly publish articles 
about using iTunes and iOS devices, as well as articles about my 
favorite music and more. 

•	 Kirk’s iTunes Forum: This is a forum that I run where people 
can discuss iTunes, iOS devices, music, and more. You can ask 
questions and chat with other iTunes users. 

•	 The Next Track Podcast: Together with Doug Adams, the Apple-
Script expert, I host a podcast called The Next Track, which discuss-
es how people listen to music today. You can subscribe in iTunes. 

•	 Macworld: I write about iTunes for Macworld, notably a regular 
column called Ask the iTunes Guy. Macworld’s Audio section con-
tains articles and reviews by myself and others about iTunes, iOS 
devices, headphones, digital music, and more. 

•	 Apple’s iTunes and iPod support hubs: These portals to 
information about iTunes and the various iPod models provide 
access to technical notes, user’s manuals, and more. 

•	 Apple’s iTunes forums: Apple’s forums offer a way for users 
to get troubleshooting help from their peers. You can often find 
answers to the most obscure questions here. 

•	 iTunes version history: This Wikipedia page has a list of iTunes 
versions and the features added with each one. 

•	 Computer Audiophile: Although audiophiles can be a bit obses-
sive, the Computer Audiophile Web site offers useful information 
about setting up centralized media servers, playing high-resolution 
audio files, and using high-end audio equipment connected to a 
computer. There’s also a very active forum where you can discuss 
using a computer as part of your audio system. 
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About This Book 
Thank you for purchasing this Take Control book. We hope you find 
it both useful and enjoyable to read. We welcome your comments. 

Ebook Extras
 

You can access extras related to this ebook on the Web. Once you’re 
on the ebook’s Take Control Extras page, you can: 

•	 Download any available new version of the ebook for free, or buy 
a subsequent edition at a discount. 

•	 Download various formats, including PDF, EPUB, and Mobipocket. 
(Learn about reading on mobile devices on our Device Advice page.) 

•	 Read the ebook’s blog. You may find new tips or information, as 
well as a link to an author interview. 

•	 Find out if we have any update plans for the ebook. 

If you bought this ebook from the Take Control Web site, it has been 
automatically added to your account, where you can download it in 
other formats and access any future updates. However, if you bought 
this ebook elsewhere, you can add it to your account manually: 

•	 If you already have a Take Control account, log in to your account, 
and then click the “access extras…” link above. 

•	 If you don’t have a Take Control account, first make one by follow-
ing the directions that appear when you click the “access extras…” 
link above. Then, once you are logged in to your new account, add 
your ebook by clicking the “access extras…” link a second time. 

Note: If your device is incompatible with the Take Control Web site,
 
contact us at tc-comments@tidbits.com.
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but mostly just sleeping near my desk. And Rosalind the Cat, a recent 
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plots an invasion of my workspace. 

The stereo in my office, where I do a lot of listening, and where I 
played the music that accompanied me while writing this book, con-
sists of a Yamaha R-N301 amplifier, a Denon DCD-720 AE CD player, 
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Shakespeare plays; I live a few miles from the Royal Shakespeare 
Company’s two theaters in Stratford-upon-Avon, England. If you’re 
a Shakespeare buff like me, check out my articles about Shakespeare 
and his plays. 

The soundtrack for this book included music by Nobel laureate Bob 
Dylan, The Clash, John Foxx, Miles Davis, John Coltrane, Bill Evans, 
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Johnson, and many others. It’s a delight to be able to write about 
software that manages music while listening to so much great music. 
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